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1 INTRODUCTION 

The I-CUBE Facial software Discovery System is designed for use 
within general surveillance for marketing.  This system is based 
upon a Client-Server architecture, whereby the Server application 
generates and stores all facial biometric templates that are 
subsequently distributed to one or more Discovery Client 
applications.  Both the Discovery Client and Server applications 
perform facial tracking, 
enrollment, verification 
(one-to-one identification) 
and classification (one-to-
many identification) 
operations.  In addition, 
Discovery Client 
applications are fully 
functional when 
disconnected from the 
Server.   
 
 

Figure 1. The FRS Discovery main screen. 



Barry Fryer Dudley Page 4 of 26 6/27/2007 

Discovery • 4 
 

Copyright ©2007, I-Cube  All Rights Reserved. 
 

 

1.1 Applicability 
This document explains the use of the Discovery 2.3 software for MARKETING 
SOLUTIONS 

1.2 Explanation of Biometrics 
In order to work with the Discovery system, it is beneficial to understand the basic 
concepts of system operation. 
 
Each User that is registered within the Discovery system has an associated facial 
biometric template, which is the information used to classify or verify the User. 
 
Biometric access control relies on three mechanisms: enrollment of the users biometric 
data (facial images), generation of the biometric templates using the enrolled facial 
images, and subsequent identification of the user, applying the biometric template. 

1.2.1 Tracking 

In order to make face recognition non-intrusive and flexible, the Discovery system 
automatically locates and follows any human face that is within the camera’s field of 
view. This allows the individual to act in a natural manner with freedom of movement 
and locomotion, and minimal cooperation with the system. 

1.2.2 Enrollment 

Enrollment is the capturing and storing of facial images of the user, in order to generate 
the facial biometric template. The greater the volume and quality of the enrollment 
images, the faster and more reliably the system will recognize the user during 
subsequent verify or classify operations. Enrollment is performed by clicking the “Add” 
button on the main screen. 

1.2.3 User Registration 

In the Discovery system, a user may be registered before they are enrolled. This means 
that users may be entered within the database without enrollment of facial images or 
storage of an associated biometric template. Registration may be performed for one 
user at a time through a dialog, or through a batch operation by loading ASCII text 
files. 
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1.2.4 Training 

Biometric templates are continuously updated through a process referred to as 
"Training" using facial images captured during enrollment operations or during 
subsequent verify operations. This ensures that the biometric templates are as up-to-
date as possible. 

1.2.5 Classification 

If a users identity is not known, the classification operation may be used to identify the 
individual from the group of facial templates loaded within the system. Classification 
works by attempting to match the unknown user against all users currently enrolled in 
the Discovery database. This process is also referred to as one-to-many identification. 
The maximum number of people that may be enrolled within the system is 5000, prior 
to a noticeable delay being introduced during the classification operation. 
 
Classification is used primarily in surveillance applications. 
 
The system can be configured to activate a sign, etc., through a relay control on 
successful classification (one-to-many identification) of a user. The system may also be 
configured to send messages to a remote computer through the NetAlert interface. 

1.3 System Overview 
The Discovery system is based upon a two-tier client/server architecture. The system 
consists of a single Discovery Server application either running as a standalone 
application, or connected to one or more Discovery Client applications. All FRS data 
pertaining to images and biometric templates are stored centrally on the Discovery 
Server and facial recognition operations may be performed on either Server or Client 
machines.   
 
The Discovery system is setup such that the 
server machine contains the FRS Central 
Server, FRS Training Server, database and 
Client application running locally. These 
components provide the core biometric 
template generation, data storage and 
communication to external Discovery Client 
applications.  

Figure 2. Discovery Client/Server system. 
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2 Using the Discovery Application 

This chapter describes the basic operation of the Discovery system, and how to adjust 
operational parameters. 
 

2.1 Basic Operation 
The Discovery system operates in two views: Standard, and Full-screen. 
 
In Standard view, all functionality is available through menus and buttons, and 
classification values are graphically displayed. In Full-screen view, the live video display 
fills the entire screen. Program controls are available through right-click menus. 

2.1.1 Standard View 

The main screen of the Discovery is shown below in Standard view. 
 
The Control Buttons on the left side of the screen allow the Operator to run the 
program in the various modes (i.e. track-only, classify, verify) as well as adjust 
operational settings and change views.  
 
The Confidence Window in the upper right of the screen provides a display of 
recognition confidence levels for Classify and Verify operations.  This window also 
functions as a progress bar during enrollment (Add) operations. 
 
Tracking Boxes and Closest Matches are shown in their respective modes. 



Barry Fryer Dudley Page 8 of 26 6/27/2007 

Discovery • 8 
 

Copyright © 2004, Acsys Biometrics. All Rights Reserved.  

Figure 3. Discovery Standard view. 

 
 
 
All of the control provided through the buttons are duplicated in the Control menu with 
the exception of the Full-Screen button.  Full screen control is provided in the View 
menu. 
 

 
 
Functions provided by the control buttons are described below. 
 

2.1.1.1 Classify Mode 

Click on the Classify button or select Classify from the Control menu to enable 
Classify mode (one-to-many identification). 
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While in Classify mode, the application will attempt to identify tracked faces from the 
list of users currently enrolled within the system. The results of the classification 
attempt are displayed in the upper right of the screen in the Confidence Window. When 
a individual is tracked, and the classification attempt begins, a thumbnail of the tracked 
face is placed in the upper-right corner of the Confidence Window. Two bars will display 
the actual confidence values. The bar on the top will display the highest confidence 
value produced across all users that are currently enrolled. A positive confidence value 
is shown in green and a negative confidence value in red. The second bar displays the 
difference between the highest confidence value that is generated for the tracked 
individual and the second highest confidence value. 
 
The classification threshold is displayed as a tick mark below the confidence display bar. 
The generated confidence value must exceed this classification threshold while the bar 
is green, in order for the individual to be classified (i.e. identified). The Confidence 
Window shown below displays results for up to two tracked individuals. 

Figure 4. The Confidence Window detail. 

 
 
 
If a user is classified (i.e. identified), their name will be displayed on the left of the 
Confidence Window. If a user is not classified within a timeout period, then “Unknown” 
will be displayed. 
 

2.1.1.2 Show Closest Matches 

Click on the 5-Close button or select Closest Matches from the Control menu to 
display the 5 closest facial matches from the list of users currently enrolled within the 
system. The system must currently be operating in Classify mode to enable the display 
of closest facial matches. 
 

 
 
The closest matches are displayed on the right side of the screen and are shown in 
descending order of recognition confidence. 
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A portrait image of each user within the closest matches list is displayed along with 
their names and the associated recognition confidence values.  Click on the 5-Close 
button again to disable display of closest matches. The system will remain in Classify 
mode. 

2.1.1.3 Add New User 

Click on the Add button or select Add from the Control menu to add a new user to the 
system and start the enrollment process. 
 

 
 
When the Add button is clicked, the “Enter Name” window will appear..  

Figure 5. The Enter Name window of the Add User function. 

 



Barry Fryer Dudley Page 11 of 26 6/27/2007 

Discovery • 11 
 

Copyright © 2004, Acsys Biometrics. All Rights Reserved.  

 
•  Enter the User’s first name in the First Name box. 
•  Enter the User’s last name in the Last Name box. 
•  Enter the User’s card number in the ID Number box. 
•  Enter the number of images you wish to collect of the User in the Number 

of Images box. 100 is the default value. 
•  Click OK. 

 
The enrollment process will begin whereby facial images of the user are collected and 
subsequently added to the FRS database. The enrollment progress is shown within the 
Confidence Window. A green progress bar will move further to the right with each 
image that is collected. 
 
When the number of images specified in the “Number of Images” box have been 
collected, the enrollment operation will terminate. If the system times out prior to 
capture of the specified number images, or the user leaves the cameras frame for a 
period of time (default 20 seconds), the enrollment operation will fail. The default value 
for the timeout condition can be modified in the Enrollment options (Section 3.2.3). 
 
When the enrollment operation has finished, the user will be asked to accept the 
enrolled images. The Accept Images window provides the operator the option to 
remove facial images of poor quality or images of people who may have been 
incorrectly tracked during the enrollment operation. 

Figure 6. Accept Images window is shown at the end of enroll. 

 
 

The operator may scroll through the collected images using the  and  buttons. 
Single images may be removed by selecting the image and clicking the Remove 
button. 
 
If the operator is satisfied with the enrolled images, click the OK button to accept 
images and allow the system to begin generating the biometric template for that user. 
 
The system will collect images faster if the user being enrolled provides different 
expressions, at different head angles, lighting conditions and at varying distances from 
the camera. It is normal for users new to the system to stare fixedly at the video 
display. To achieve optimal performance, you must create a situation in which the user 
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is moving their head and walking to create varying lighting conditions.  The operator 
should instruct the user to move naturally and/or walk towards the camera. 

 
The system may also be set to issue verbal commands to the user in order to Guide the 
enroll procedure (see the “Setting Up Speech” section at the end of this chapter). 

2.1.1.4 Show Options 

Click the Options button or select Options from the Control menu to display the 
Options window. 
 

 
 
The Options window allows the user to modify operational settings within the Discovery 
system. See the “Options” section for a detailed description of the Discovery system 
options. 
 
The Acsys Discovery may be setup to require a password in order to change options. If 
the password option is set the following window will appear when clicking the Options 
button.  Enter the Options password and click OK. 

Figure 7. Password dialog. 

 
 
The Options password protection is enabled and disabled in the General tab of the 
Options window.  

2.1.1.5 Full-Screen View 

Click the Full-Screen button or select Full-Screen from the View menu to switch 
Discovery to Full-Screen view. 
 

 
 
In Full-Screen view, the video window expands to fill the entire display. All controls 
shown in Standard view will be hidden. A subset of the controls are available in Full-
Screen view through a right-click popup menu. See the Full-Screen View section later in 
this chapter for details. 



Barry Fryer Dudley Page 13 of 26 6/27/2007 

Discovery • 13 
 

Copyright © 2004, Acsys Biometrics. All Rights Reserved.  

2.1.1.6 Exit 

The Exit button is located at the bottom right of the Discovery application when in 
Standard view. 
 

 
 
This button closes the application. Note that closing the Client application on the Server 
machine does not stop the Server application. For information on terminating the Server 
Application refer to Chapter 4. 
 

2.1.2 Full Screen View 

By switching to Full-Screen view, the video window will expand to fill the entire display 
area. All menus and controls will be hidden. 
 
In Full-Screen view, the user has control over a subset of the Standard view’s 
operational features. These operational features include: 
 

•  Track Mode 
•  Classify Mode 
•  Verify Mode 
•  Add New User 
•  Show Closest Matches 
•  Show Options 
•  Exiting the Application 

 
Database editing and display features are not available in the Full-Screen view. 
To exercise the features in Full-Screen view, right-click anywhere on the screen. A 
popup menu will appear. Select the desired feature from the popup menu. 

Figure 8. Popup menu for full screen mode. 

 
 
To return to Full-Screen view, press the ESCAPE key. 
 
While in Full-Screen view, Closest Matches mode will display the closest matches on the 
right side of the screen. 
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2.2 Setting Operating Parameters 
The options form allows the User to adjust various operating parameters of the 
Discovery system. This form is enabled by clicking the 
Options button outlined in the previous section. The 
options form is divided into eight tabbed sections. 

2.2.1 General Tab 
 

The tab shown below allows the operator to adjust 
options that pertain to continuous re-generation 
(training) of the biometric templates used during 
classify and verify operations, options for automatic 
brightness compensation, enabling speech synthesis, 
password protection on program variables, changing 
the Discovery Server and resetting parameters to 
default values.  

Figure 9. Options window - General tab. 

 

2.2.1.1 Brightness Control Panel 

Brightness control adjusts the video capture driver to compensate for mean pixel 
intensity located within the region of the tracked face. Hysterysis is applied to 
brightness control and limits the amount of compensation applied. 

2.2.1.2 General Panel 

The facilities provided within the Common panel allow the operator to enable or disable 
synthesized speech, reconnect to a different Discovery Server and provide password 
protection for program option settings. 

Enable Speech 
By default, synthesized speech within the Discovery Client application is not enabled.  
To activate speech, check the Enable Speech box. Click OK and restart the Discovery 
application. Speech synthesis will now be enabled for all operations such as enroll, 
classification, and verification. 
 
See the “Setting Up Speech” section later in this chapter for details on customizing 
speech. 
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Change Server Name 
This control is enabled only for Discovery Client machines. If this control is checked, the 
Discovery system will request the Server name on the next start up of the application. 
This feature allows the user to connect the Discovery Client to a different Server within 
the network. 

New Password  
The operator may enable password protection for the setting of options and pushbutton 
configurations.  Password protection is disabled by default.  Entering characters within 
this text box and confirming text box enables password protection.  Password 
protection may be disabled by clearing the password and confirming text box.  

2.2.1.3 PECOS Interface 

The PECOS Interface extension allows the Discovery System to send alarms to the 
PECOS system, and to wireless Pocket PC devices that interface directly to the PECOS 
system.  
 
The PECOS protocol is a TCP-based 
message that allows external systems to 
send alarms and alarm information to the 
PECOS system.  Each message is atomic, 
and requires no reply from the PECOS 
system. Messages are 7-bit ASCII text 
and require no handshake. 
There are two versions of the PECOS 
protocol. Each version defines a READY 
message and a MATCH message. Version 
1 is extended to include Pocket PC 
support.  The dialog for configuring the 
PECOS interface is shown below: 

Figure 10. PECOS Interface Options dialog. 

General Settings 
Enabled Checkbox 
When this checkbox is enabled, the extension will send messages to the computer 
(PECOS server) specified by Server Address and Port, using the version protocol 
specified in the Protocol Settings. 

Protocol Settings 
Use Version 1 
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When this option is selected, both READY and MATCH messages will be sent to the 
machine specified by Server Address and Port. “PDA Application Settings” are only 
available with Version 1. 
 

Use Version 2 
When this option is selected, pseudo-XML messages will be sent to the machine 
specified by Server Address and Port. These messages will contain detailed information 
regarding User, Location, Time, and alarm type. A snapshot is also embedded in the 
Version 2 message. PDA Application Settings are not available with Version 2. 
 

Server Address 
IP Address or UPC name of the machine to which all messages will be sent. This should 
be the machine on which the PECOS server resides. If a UPC name is used, it must be 
registered with your network’s DNS. IP Addresses are generally more reliable. 
 

Port 
Port on the machine that will receive messages. The Port number must match between 
PECOS system server and this extension. All external systems connect to PECOS on the 
same Port. Valid port numbers range from 1 to 49151. 

Pocket PC Application Settings 
Send Alarms to Pocket PC 
When this flag is set, and Version 1 has been selected, and the extension is enabled, 
the extension will send messages to the PECOS Pocket PC system on classification. 
 

Application Folder 
Path to the Pocket PC application on the Jakarta server 
that hosts the PECOS web application. This value can 
only be set if the Send Alarms to PDA flag is checked. 
The path is chosen by clicking the browse button to the 
right of the field. 
 

Alarm Folder 
Alarm sub-folder of the PDA Application Folder for the 
PECOS web application. This folder will receive all XML 
files generated by the PECOS extension. This value 
cannot be set until the Application Folder is set. The 
folder is chosen by clicking the browse button to the 
right of the field. 
 

Image Folder 
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Image sub-folder of the Alarm Folder for the PECOS web application. This folder will 
receive all JPEG files generated by the PECOS extension. This value cannot be set until 
Alarm Folder is selected. This folder is selected by clicking the browse button to the 
right of the field. 

2.2.1.4 NetAlert Server 

This extension enables a Pocket PC equipped with wireless communication to receive 
HTML alarm messages and JPEG images from the Discovery System. The dialog for 
configuring the NetAlert Server that provides messages to the Pocket PC is shown 
below: 

Figure 11. NetAlert Properties dialog. 

 

 
The following check boxes are used to enable messages to the Pocket PC. 

Enabled 
Enables and disables the notification of security alerts. The Discovery System will only 
send messages to the Pocket PC when this box is checked. 

Face Classified. 
Sends an alarm to the Pocket PC when a user is successfully classified (one-to-many 
identification). 

Face Unknown 
Send an alarm to the Pocket PC when a classification operation times out. 

 
The following filenames must be entered into the text boxes in the lower section of 
dialog in order for the system to function.  

Path to FRS Surveillance Log file 
The NetAlert Server receives its information from the FRS Discovery log. Set the path to 
the log file here. This path must be set before NetAlert will function! 

HTML Template Files 
The alarm messages are sent to the Pocket PC in HTML format. Templates have been 
used to allow the user to change the appearance of the HTML page. The entry 
templates are stored as UTF-8 text. The default installation will place these files in 
folder c:\andface.  The following three templates are used to generate each HTML page 
and either the pre-configured or modified templates must be assigned. 
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HTML header template 
The HTML source code that precedes the alert information. Any header or meta 
information normally goes here. The filename for the header template is header.txt 

HTML item template  
Used to display the HTML code for each alert. The filename for the item template is 
entry_templtate.txt 

HTML footer template  
The HTML code that follows the alert items. The filename for the footer template is 
footer.txt 
 
Server Database  
The database of facial images may be viewed and edited only from the Discovery 
Server machine. The operational features provided under the database menu item are: 
 

•  Viewing and deletion of images stored within the FRS database and applied 
during biometric template generation 

•  Clearing and regeneration of all biometric templates stored within the 
database 

•  Batch pre-registration of users from an ASCII text file 
•  Enrollment of users from static (JPEG) images 

2.2.2 Editing the  Database 

The “Edit Database” utility allows the operator to view and delete images stored within 
the Discovery Server database and used in generation of biometric templates. To 
enable this screen select Edit Database from the Database  menu. 
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Figure 12. Edit Database window. 

 
 
From the Edit Database screen, the operator may remove any subset or all training 
images for the selected user. The set of registered users is shown in the list box located 
on left side of the screen. Users are listed by [lastname, firstname] and ID number. 
 
The name of the currently selected user is shown in the Select User box.  The facial 
images that are stored for the currently selected user are shown in the right panel. 
 
The list of enrolled users may be sorted by clicking on the Name or Card column 
header. Clicking on the Name column header will sort the users alphabetically by name 
in ascending or descending order. Clicking on the Card column header will sort the list 
by Card number in ascending or descending order.  
 
To select a different user for display and editing, click the associated name in the list 
box, or enter a name in the Select User box and press ENTER. Users may be searched 
by Name or Card number. 
 
To search for a specific user by Name, click on the Name column header to pre-sort 
the list, then enter the users last name or the beginning letters of the last name in the 
Select User box, and press ENTER. 
 
To search for a specific user by Card, click on the Card 
column header to pre-sort the list, then enter the user's card 
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number or the beginning digits of the card number in the Select User box, and press 
ENTER. 
 
To edit the users information, double-click on the user name in the list box. The 
following Update User dialog will appear. 

Figure 13. Update User dialog. 

 
 
In the Update User dialog, you may change the first name, last name, and card 
number. 
 
To delete a user, right-click on the users name in the list box and select Delete. Multi-
select may also be applied when deleting users. 
 
To delete an image, select by clicking on the image and a blue boarder will appear. 
Click the Remove button. The image will be removed from the system and is no longer 
applied during template generation. 
 
You may multi-select images for removal by clicking on the first image you wish to 
remove, then hold down the SHIFT key and click on the last image within the image 
set. All the images between the first and last images will be selected. Click on the 
Remove button to remove the selected images. 
 
Click the Remove all button to remove all training images for the currently selected 
user. 

2.2.3 Exporting Users 

Users may be exported from the Discovery database for subsequent import into a 
separate Discovery installation. To export a user or multiple users, select the user(s) 
within the list box, right-click and select Export Users. A common file dialog will 
appear. Enter the name of the file that is to contain the exported data and click Save. 
All data including training images, will be exported to the file. 

2.2.4 Importing Users 

Users may be imported to the Discovery system from a previously saved export file. 
Select Import Users from the Tools menu and choose the file to be imported. The 
Discovery application will create a new user within the Server database for each user 
stored within the export file. 
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2.2.4.1 Import Options 

During import of users, it is possible that 
the export file contains one or more user ID 
numbers that already exist within the 
current Discovery database. To deal with 
possible duplication of user IDs during 
import, the Import Options dialog provides 
two methods. To access the Import Options 
dialog, select Import Options from the File menu. 

Figure 14. The Import Options dialog. 

 
 

Reject all duplicate CardID numbers 
If this option is selected, only users with unique ID numbers will be imported. If a user 
ID within the export file conflicts with a user currently enrolled within the database, the 
user will not be imported and the import rejection logged. 

Reject duplicate CardID numbers with unmatched names. 
If this option is selected, imported users with conflicting ID numbers will be discarded if 
their name cannot be matched to the user currently enrolled within the database. If an 
existing user has both the same ID number and name, the imported image set will be 
merged with the image set currently stored within the database. 

2.2.4.2 Import Log 

The progress of the import is saved to a text file. Any rejections will appear in the 
import log. The import log resides on the server and stored as “importuserslog.log”. 

2.2.5 Regenerating Templates 

Select Retrain All from the File menu of the Edit Database window in order to clear all 
biometric templates and regenerate (i.e. train) the templates across all users currently 
stored within the Discovery database. Once a retraining 
operation has begun, the biometric templates across all 
users are cleared, and a classification or verification 
operation will not function until all templates have been 
regenerated. Regeneration of templates requires 
approximately 10 seconds per user.  

2.2.6 Pre-Registration of Users 

Users may be added (registered) within the Discovery 
database without performing an enrollment operation (i.e. 
facial image collection). This operation is referred to as 
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pre-registration. Pre-registered users are enrolled at a later time, through use of either 
the Wiegand interface (i.e. card reader or keypad device) or the “Add” push-button 
control located on the main screen. 
 
To pre-register a user or group of users select Pre-register User from the Database 
menu. The following Pre-Register Users window will appear. 

Figure 15. Pre-register Users dialog. 

 
 

For pre-registering a single User: 
 

•  Enter the User’s first name in the First Name box. 
•  Enter the Users last name in the Last Name box. 
•  Enter the last 5 digits of the User’s card number in the Card ID box. 
•  Click Insert. 

 

The single User will be added to the database, however a biotemplate or enrollment 
images will not exist for that User. 
 

To pre-register a group of Users: 
 

•  Click the Select File button. An “Open File” dialog control will be shown. 
•  Select the name of the file containing the User information and click Open.  
•  Click the Pre-Register button to import the list of User names and ID 

numbers. 
 

The file containing the Users 
must contain 7-bit ASCII text 
only. Each line must be 
terminated by a carriage-return 
line-feed pair.  Each line in the 
text file represents one User. 
Each line contains last name, 
first name, and card number 
delimited by commas as 
follows: 

Sample User file. 

Chen, Jack, 38169 
Foss, Philip, 38163 
Sandler, Gregory, 22283 

2.3 Enrolling from Static Images 
The Discovery system includes facilities to import static JPEG images from a file, and 
apply these images for enrollment (template generation).  Ideally, multiple images 
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should be enrolled in order for the system to perform verification or classification 
operations reliably.  Enrollment of static images may be performed in conjunction with 
the standard video enrollment procedure. 
 
To perform an enrollment from static images, select Enroll Static Images from the 
Database menu. 

Figure 16. Enroll Static Images window. 

 

2.3.1.1 Enrolling a New User from a Static Image 

A new user may be enrolled from a static image. The system will automatically assign 
the new users name and card number based on the filename of the JPEG. The JPEG file 
name must have the following format: 
 
[LASTNAME]_[FIRSTNAME]_[CARDID].jpg 
 
For instance, a JPEG file with the name “Doe_John_25463” will create a user named 
John Doe, with ID number 25463. 
 
To enroll a new user from a static image: 
 

•  Select From File Selection. 
•  Select the JPEG file from the file list located in the upper left corner of the dialog. 
•  Select New User within the user list. 
•  The JPEG image will appear in the image box. The person’s face will be tracked 

automatically. If no tracking box appears around the face, click the Retrack 
Face button 

•  When the face is located in the image, click the Start Enroll button. 

2.3.1.2 Adding a Static Image to an Existing User 

You may add static images to the training set of an existing user. Files used to add 
images to existing users do not require the file name format indicated above. 
 
 
To enroll a static image for an existing user: 
 

•  Select From File Selection. 
•  Select the JPEG file from the file list in the upper left corner of the dialog. 
•  Select the target users name in the user list box. 
•  The JPEG image will appear in the display screen located on the right side of the 

dialog. The users face will be tracked automatically. If no tracking box appears 
around the face, click the Retrack Face button 

•  When the face is located in the image, click the Start Enroll button. 
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2.3.1.3 Batch Enrolling of Static Images 

Multiple users may be enrolled in batch mode from a set of JPEG images. Each image 
that is enrolled will create a new user within the system. The system will automatically 
assign each new users name and card number based on the filename of each JPEG file. 
The JPEG file names must have the following format: 
 
[LASTNAME]_[FIRSTNAME]_[CARDID].jpg 
 
For instance, a JPEG file with the name “Doe_John_25463” will create a user named 
John Doe, with card number 25463. 
 
To enroll multiple users from static images in batch mode: 
 

•  Select From File Folder. 
•  Select the folder containing the JPEG files from the file list in the upper left 

corner of the dialog.  
•  Click the Start Enroll button to initiate enrollment of all users stored within the 

file folder. 
 
The system will report if it was unable to locate a face in any of the JPEG images. If the 
system is not able to locate a face or the assigned ID number is currently used, it will 
not perform the enrollment operation for that image file. Following batch enrollment, 
the system will report the number of users enrolled and list the images that could not 
be enrolled within the file EnrollStaticImage.log. 
 

2.4 Activity Log Viewer 
The Activity Log Viewer displays all events that have occurred within the Discovery 
Client/Server installation. Included in the log report is the time and date in which the 
event occurred, the Discovery client machine at which the event occurred, the 
associated user name (if any) and type of event. The Log also records an image from 
the client when the event occurs. 
 
The activity events that are recorded within the Log are as follows: 
 

•  Enroll Failure (Face) 
•  Enroll Success 
•  Reenroll 
•  Verify Failure (Face) 
•  Verify Success 
•  Face Classified 
•  Face Unknown 
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Multiple activity logs data may be viewed using the multiple document interface. Each 
view may be filtered to list events by event date, client computer, User name, and 
event type. 
 
The Activity Log may also be saved or restored from a delimited text file. 

2.4.1 Showing the Activity Log 

In order to display the activity log, perform the following operations: 
 

•  Click the Windows Start button. 
•  Select Discovery Log Viewer from the Start menu. 
•  Click OK on the “Display Filter” window. The Discovery Log Viewer will open 

showing all activity events. 

Figure 17. Discovery Log Viewer window. 

 
 

2.4.2 Filtering an Existing View 

To filter the events in an existing view, select the view that you want to filter, then 
select Filter from the Window menu, or click the Filter button. The following Activity 
Log Filter dialog will appear. 
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Figure 18. Activity Log Filter dialog. 

 
 

•  Select the filter criteria. You may filter on a single User name, Client 
Computer, the Activity Category or range of dates. Selecting multiple criteria 
will form a union of all selected filter criteria. 

•  Click OK. The view will filter the events based on the selected criteria. 

2.4.3 Opening a New View 

To open a new window with a different filter, select New from the File menu in the Log 
Viewer, or click the New button. The Activity Log Filter dialog will appear. Select the 
filter criteria then click OK. The new view will open in a new window. 

2.4.4 Saving the Activity Log  

The data from the current view can be exported to a text file for later viewing. Note 
that images are not exported when saving the activity log. To export the activity log 
perform the following operations: 
 

•  Select the view that contains the data to be exported. 
•  Select Save from the File menu. A standard File dialog will appear. 
•  Enter the name of the file used to save the activity log. If you choose an 

existing file, it will be overwritten. 
•  Click OK. The activity log will be saved to the specified file. Activity log files 

have the “.log” extension. 

2.4.5 Loading the Activity Log 

The data from an activity log file can be loaded into an existing view. To load an activity 
log perform the following operations: 
 

•  Select the view that will receive the activity log data. Note that the loaded 
data will overwrite the current view’s data. 

•  Select Load from the File menu. A standard File dialog will appear. 
•  Locate the activity log file to view. Activity log files have the “.log” extension. 
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Click OK. The activity log file will be loaded into a new view.  

3 Technical Support 

For further information or technical support contact I-Cube technical support. 
Phone: (031) 764 3077  
Email: images@I-Cube.co.za  
 
 


